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RiskyProject for Microsoft Project and as a 
Standalone Application 

RiskyProject as a Standalone Application 
You may run RiskyProject from Windows program menu. Just click on RiskyProject Lite 3.x 
under RiskyProject 3.x. You will be presented with a RiskyProject main frame where you can 
enter schedule and risk, perform the analysis, track project performance and report the results.  

The RiskyProject workflow includes five major steps. Each step includes a number of activities 
and each activity is associated with at least one RiskyProject view. 

The five major steps of the RiskyProject workflow are: 

1. Create or import a project schedule, which includes tasks, resources, and costs; 
2. Add and uncertainties to the project, assign risks to specific tasks and resources, or make 

them global; 
3. Perform calculation and analyze results; 
4. Track project performance; and, 
5. Report results. 
 
Each step is associated with the tan on RiskyProject workflow bar. Use these steps to perform the 
analysis. 
 
Before you create new project please you may need to  define: 
1. Main Project Settings, such as project start time: choose Main Project Settings from Project 

menu. 
2. Calendars: choose  Working Time from Tools menu 
3. Various project options, such as units, default calculation settings: choose  Options from 

Tools menu. 

RiskyProject for Microsoft Project 
RiskyProject is seamlessly integrated with Microsoft Project 2003 and higher. When RiskyProject 
is installed it checks if Microsoft Project is installed on the computer and adds a RiskyProject 
toolbar and macro to Microsoft Project.  

Here is how the integration works: 

1. The first time you open Microsoft Project after installing RiskyProject for Project, check to 
see that the RiskyProject toolbar is visible.  

2. Create a schedule in Microsoft Project. 

3. Click one of buttons on the RiskyProject toolbar in Microsoft Project to go to selected 
RiskyProject view. Essentially, RiskyProject offers additional risk related views to Microsoft 
Project such as risk adjusted Gantt Charts, Risk Matrixes, a risk adjusted cash flow charts and 
others.  

4. Add risks, uncertainties, and other risk-related information in the RiskyProject views. 

5. Run the simulation, perform the analysis and report the results from RiskyProject. 
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6. At any moment you can go back to Microsoft Project and make changes to your schedule. All 
changes will be reflected in RiskyProject. However if you make changes to the deterministic 
project schedule in RiskyProject, these changes may be overwritten by Microsoft Project 
schedule. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Risks and uncertainties defined in RiskyProject will be always associated with Microsoft 
Project schedule. Once you have opened a risk view from your Microsoft Project file, your 
Microsoft Project file will be associated with the RiskyProject data file that contains risks and 
uncertainties for the schedule created in Microsoft Project 

2. Links between the Microsoft Project schedule and the RiskyProject data is saved in the 
registry. We recommend the save RiskyProject file (alm extension) in the same directory as 
your Microsoft Project file, though the RiskyProject file can saved in any directory.  

Click the Go Back to Microsoft Project button in 
RiskyProject to view original schedule and resources 

Use the RiskyProject toolbar in 
Microsoft Project to open the selected 
risk view in RiskyProject.  

Microsoft Project RiskyProject Lite 
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Creating Projects 

Creating a new project 
The original view for a new document is defined in the Options, View tab. The default view can 
be the last view in the previous RiskyProject session. 

1. On the File menu, click New. The new project file opens. 
2. Click the Save button and type in a project name. 

 

In addition to projects files created in RiskyProject, you can also open files that have been saved 
as a Microsoft Project XML or MPX format. These formats are industry standards for project 
management software and are supported by Microsoft Project and many other project 
management software applications. 

 

Importing existing project schedules 
You can import existing project schedules from MS Project, Primavera and other project 
management tools using a variety of file formats.  

Importing Microsoft Project files 

You can import MS Project files using MPX, or XML formats.  

1. From the File menu, choose Open. The Open File dialog box opens. 
2. Select the format that the project file is in from the Files of type drop-down list. 
3. Select the MS Project file format that you just saved. 
4. Click OK.  

 

Due to the specific features of each application and the probabilistic nature of RiskyProject data, 
in very rare cases there can discrepancies in the original project schedule and imported schedule 
in RiskyProject.
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Project Tasks 
When you first start RiskyProject, the Gantt view opens. Start the scheduling process by adding 
tasks. Each task should have a name and a base duration. You may enter this information directly 
onto the datasheet or using the Task Information dialog box. 

Opening the Task Information dialog box 

The Task information dialog box can be used to enter task parameters (duration, start, finish 
times, assign resources to tasks, assign risks, etc.). You can open the task information dialog can 
in invoked using one of the following ways: 

 Double click on Task ID 
 Right click on task ID and Select Task Information 
 Select Task and Click on Project -> Task Information 

Entering task name and duration 

When you create a task, the first step is to enter a name and a base duration. 

1. Click on the Task Name field in the Gantt view.  
2. Provide a name for task. 
3. Enter a base duration in the Base Duration field.   

 

The default Start Time for tasks is defined in the Calendar tab of the Options dialog box. The 
start time can be either the current date or a project start date, defined in Project ->Main Project 
Settings. You can always change start time using constraints (see Start, Finish Times and 
Constraints). You can also change other default parameters in the Options dialog box. 

 

 Define task durations using the Base Duration column. Once you have added all of the tasks, 
you can add uncertainties by assigning low and high durations. 
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Defining summary tasks and subtasks  

Summary tasks represent groups of tasks (subtasks) that can be logically grouped together under a 
larger task. In large projects with many tasks, this is a useful method of organizing your tasks. 

1. Create a task directly above the tasks that you want to group under it. This will become the 
Summary Task. 

2. Select the tasks that you want to be the subtasks of the summary task you created in step 1. 
3. Click the Indent button located on the Format toolbar to indent the tasks. The indented tasks 

are automatically recognized as subtasks of the summary task. If you want to move at task out 
from under the summary task, select the task and click the Outdent buttons. After you click 
on an Indent or Outdent button, RiskyProject automatically recalculates the project. 

 

 

Task Links 
All projects require that the WBS tasks be performed in a certain order. These relationships are 
defined in RiskyProject using the four linking buttons located on the standard toolbar. 

  

The four types of task dependencies are show in the following figure: 
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Predecessors and Lags 
You define information about predecessors and lags in the Predecessor tab of Task Information 
dialog box. 

You can use the Standard toolbar button to link tasks; however, this method of creating task 
dependencies has limitations. Particularly you cannot link a task (from example Task #5) to a 
previous task (for example Task #3). 

 

 Sometimes it is convenient to use predecessor tab instead of link toolbar buttons when 
task has multiple predecessor or if there is a big difference in task Ids between current 
task and predecessor. For example, it is not convenient to link task number 5 to task 
number 74 using toolbar buttons. 

 You may use Predecessor column within Gantt view to define or modify predecessors. 
Text: “1, 2+2 days” would mean than current task has two predecessors (Task 1 and Task 
2 with lag 2 days). 

 

Adding a predecessor to a task 

1. Select the task to which you want to add a predecessor. 
2. Open the Task Information dialog box.  
3. Click the Predecessor tab. 
4. On the first row of the grid, click in the Task Name cell. A drop-down list appears containing 

a list of all available tasks or type  
5. Select the predecessor from the drop-down list. By default, the predecessor type is Finish- 

Start (FS). 
6. If required, enter a lag time 
7. Click OK. 

 

 You cannot  make a task be a predecessor to itself 
 You cannot create a schedule that it will lead to a circular relationship between tasks 
 You cannot link a summary task to one of its subtasks 
 You cannot link two tasks twice. 

 

Constraints  
Constraints are limitations that you set on tasks. For example, you can specify that a task must 
start on a particular date or finish no later than a particular date. In RiskyProject, you can assign 
one of four constraints to a task: 

 As Soon As Possible (default) 
 Start Not Early Than 
 Must Start On 
 Must Finish On  
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Use the General tab of Task Information dialog box to add or modify constraints. If you set a 
constraint to Start Not Early Than, an additional edit box opens in which you set the date for this 
constraint. 

If you assign a constraint other than As Soon As Possible, the background color for low, base, 
and high Start Times or low, base and high Finish Times changes to orange and the icon next to 
the task name has a red dot added to indicate that the constraint is other than As Soon As 
Possible.  

 

Use constraints to ensure that that task starts or finishes on the specific dates.  Use caution when 
you link tasks with a constrained start or finish time with predecessors because of the potential for 
scheduling conflicts. In this situation, to avoid scheduling conflicts, set the constraint to As Soon 
As Possible.  

Constraints affect both probabilistic and deterministic calculations. If you change the Low or 
High Start times, the constraint is set to Must Start On, similar to when you change the Base Start 
time. 

 

When a task has a constraint other than As Soon as Possible, it may not shift due to the nature of 
Monte Carlo calculations, even if predecessors have risks and uncertainties. Therefore, use 
caution when you planning to perform probabilistic calculation with constraints. 

When you enter actual start date of the task as part of tracking input, task would become 
constrained for the probabilistic calculation only.  Start time will not change regardless of risks 
and uncertainties for predecessors. 

Adding constraints 

Before you add a constraint, you should define the task name and duration. 

1. Double-click the task to which you want to add a constraint. 
2. Click the General tab. 
3. From the Constraints drop-down list, select a constraint that you want to add to the task. 
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Managing Resources and Work 
Resources are the people and equipment that are assigned or the material that is used to complete 
a task. 

Adding resources 

1. On the Workflow bar, click the Resources view. 
2. Click on a row. 
3. Provide a Name (mandatory), Initials (optional), and Rate (mandatory). 

 You can group resources to define reams using the indent and outdent buttons. 
 Initials and notes are for information only and do not affect the calculations. 
 Rates affect the cost the task to which the resource is assigned. Rates for work resources 

can be per year, month, week, day, hour and minute. Rates for material resources are per 
unit (e.g. 10 tons).    

4. Select the resource type: Material or Work.  
 Material label indicates type of material resources (e.g. tons)  
 Maximum units are used to calculate Overallocation of work resources. It is not used for 

the material resources. 

 

 Use the Resource Information dialog box to assign resources risks. 

 You can add risks to a resource using the Risk tab of Resource Information dialog box. If you 
have only a few risks assigned to a few resources, this is the preferred method to define 
resource risks. If you have many resources, we recommend that you add the risks in the Risk 
Register of Risk workflow tab and then assign them to the resources from one of the risk 
views.  

 Default rate for resource type Work is defined in Tools->Options Cost tab. 
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Assigning resources to tasks 

1. On the Workflow bar, click the Gantt View. 
2. Select the task to which you want to assign the resource. 
3. Click in the Resource field associated with the task. 
4. Select a resource from the drop-down list. If you type in a new resource name, it will be 

added to the list of resources in the resource view. When you add a new resource in this 
manner, it will be assigned at 100% effort for work resource. 

 

To assign resources at less than 100% or if want to assign material resource, you must go to the 
Resources tab in the Task Information dialog box.  

 

 Multiple resources can be assigned to a particular task. 
 Tasks do not have to have resources assigned to them.  

 

Assigning a calendar to a resource 

By default, RiskyProject assigns the Standard calendar to resources. 

1. On the Resource view, double-click on a resource ID. 
2. Select a resource calendar from the Base Calendar drop-down list. 
3. Click the Working Time button (Tools menu) to modify the resource calendar. 
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Managing Costs 
 

There are two types of costs in RiskyProject:  

 Fixed costs, which are associated with tasks; and, 
 Variable costs, which are associated with resources.  

Costs associated with resources are calculated based on rate, units assigned, and work of the 
particular resource.  

Fixed cost can be accrued at the beginning of the task, at end of the task or be prorated.  

Adding fixed costs to tasks 
The Cost Analysis view also shows the calculated results for fixed costs, resource costs, and  

1. On the Workflow bar, click the Cost Analysis view. 
2. Select the task in which you want to fixed costs. 
3. Enter base fixed cost in the Cost field. You can enter in Low and High estimated costs.  
4. Select an accrual method in the Accrual column. Accrual methods indicate how cost is 

accrued in the task. Default accrual method if defaulted in Tools -> Options, cost tab 
separately for cost. Accrual methods available are: 
 Start 
 Finish 
 Prorated 

 

 You may assign fixed cost to the summary tasks the same way as they are assigned to the 
subtasks 

 You may define uncertainties in fixed cost using low, base and high values of cost. 
 Uncertainty in variable cost is originated in task work since variable cost = resource work 

* number of units * rate. 
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Chapter 2: Managing Risks and 
Uncertainties 
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Risks and the Risk Register 

Risks in RiskyProject 
Once you have set up your Risk Outcomes, you can now set enter and assign risks to your 
schedule.  Risks can be stored in the Risk Register. Risk Register is a set of risks with input and 
output parameters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Risks in RiskyProject are defined the following manner:  

1. Name: names must  for each risk must be unique. It is case sensitive.  
2. Parameters: Parameters can be inputs or calculated. Input parameters include is it Risk or 

Issue, is this Opened and Closed, as well as multiple risk properties: date, owner, contact, 
department, area of risk, etc. You define default risk properties in the Risk menu >  Default 
Risk Properties. All risks are stored in Risk Register. 

3. Assignment : risks can have global (to all tasks or resources) or local (to specific task or 
resources) assignments. If a risk is not assigned, the impact of the risk cannot be calculated 

Risk 

Opened 
or 
Closed 

Threat, 
opportunity or 
both (calculated 
based on risk 
assignment) 

Risk properties: 
date, owner, 
contact,  
department, area 
of risk, etc. 

Risk 
or 
issue 

Input risk parameters 

Probability, 
impact and 
score before 
and after 
mitigation 

Calculated risk parameters 

Global risk assignment 
(to all tasks or resource) 

Local risk assignment. 
For example, assigned to 
task 2 

Local risk assignment. 
For example, assigned to 
resource 1 

Alternative 1: Probability, 
Outcome, Result of the 
outcome. 

Alternative 1: Probability, 
Outcome, Result of the 
outcome, moment of risk 

Alternative 2: Probability, 
Outcome, Result of the 
outcome, moment of risk 

Alternative 1: Probability, 
Outcome, Result of the 
outcome, moment of risk 

Risk register: set of all risks in the project 
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4. Mutually exclusive alternatives: each risk assignment may have one or many mutually 
exclusive alternatives. Each alternative includes chance of occurrence, outcome, and outcome 
result. 

Example 

Your project has a risk: Low quality of component. The risk has the following input parameters: 

 It is open 

 It is a risk not an issue 

 It has a number of parameters: detailed description, dates created and modified, owner, 
recorder and other information. 

You need to assign the risk to tasks or resources. This assignment information will include a 
number of mutually exclusive alternatives for to each task the risk is assigned. 

For example, the risk is assigned to the task “Component installation” with one alternative: 
Chance of occurrence 10%, Outcome: Restart Task. The risk is also assigned to the task: 
“Testing” with two alternatives: Chance of occurrence 10%, Outcome: Restart Task and Chance 
of occurrence 15%, Outcome Delay 2 days. 

Risk Register 
The risk register is a set of all risk in the project. The risk register can be populated in two ways: 

1. Directly entering risk information into the risk register view. 

2. Using the Global Risk Assignment view, Local risk assignment views for tasks and resources, 
or risk tabs in Task Information dialog and resource information dialog. Any new risks 
entered using these views and tabs will be automatically added to the risk register. 

Risk registers include the following information: 

 Risk names:  Each risk name is unique. You cannot define risk with the same name 
within risk register. 

 Risk parameters: risks can be opened and closed, risks or issues, assigned to different 
tasks or resources, and risk properties (dates, owner, contact, description, etc.). 

 Calculated risk parameters: probabilities, impact, and scores, is this risk threat, 
opportunity or both. 
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To view probabilities, impacts, and scores you must calculate the project.. 

Opening the Risk Information dialog box 

Double-click on any risk ID to open the Risk information dialog box. There you can enter risk 
parameters, assign risks to tasks and resources, and view risk mitigation information.  

Opening and closing risks  
In RiskyProject, risks can be opened and closed. Opened risks are currently active risks, which 
can occur. Closed risks are those risks, which cannot occur anymore because certain measures are 
taken.  Closed risk also may contain important information, because they can be reopened again 
or information regarding these risks may useful for management or other risks. 

When you switch a risk from opened to closed, all risk assignments are disabled. In addition, 
when you a switch risk from closed to opened, all risk assignments will be enabled. 

By default, all new risks are open.  

Marking a risk as opened 

1. On the Risks tab of the Workflow bar, click the Risk Register view. 
2. Double-click on risk ID. Risk information dialog will come up. 
3. On the Properties tab, select Opened or Closed. 

Risk names 

Threat, 
opportunity or 
both 

Risk can be assigned to specific tasks or 
resources (local) or all tasks and resources 
(global) 

Probability, impact, 
score, and “tornado” –
type diagram for the 
score. 

Double click on 
Risk ID to be 
presented with risk 
information dialog 
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Risks and Issues 
RiskyProject manages both risks and issues. Risks are an event that may occur. Issues are an 
event that has already occurred. When you enter new record to the risk register, it is a risk.  

You may switch between risks or issues. When you switch risk to issue, chance of occurrence of 
the issue would be 100%.  

Converting a risk to an issue 
1. On the Risks tab of the Workflow bar, click the Risk Register view. 
2. Double-click on risk ID. Risk information dialog will come up. 
3. On a Properties tab, select Issue. 

 

 If you switch from issue to risk, probabilities for all risk assignments will remain 100%. 
You would have manually assign probabilities to actual number of all risk assigned after 
switch it from issue to risk. 

 If the risk has mutually exclusive alternatives as part of risk assignment and this risk is 
switched to the issue, chance of occurrence will not change. In this case, it is 
recommended manually remove mutually exclusive alternatives, keep only one 
alternative and set it chance of occurrence to 100%. 

Threats and Opportunities 
Risk can be threats, opportunities or both. Threats and opportunities are defined for risk 
assignment depending on results of the risk outcome. Negative risk outcomes mean opportunities. 

Example 1: 

Risk: Change Requirements 

Outcome: Fixed Delay 

Result: 2 days 

This is threat 

Example 2: 

Risk: Change of technology 

Outcome: Delay in technology introduction 

Result: -10% Low 

This is an opportunity: a negative number indicates that this is an acceleration rather than 
a delay of the technology introduction 

Adding risks to the Risk Register 
It is a best practice to use the Risk Register to add and assign risks to your current project 
schedule.  

1. On the Risks tab of the Workflow bar, click the Risk Register view. 
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2. Click on an empty row. 
3. Provide a name for the risk. The risk is now added to the register. You can now add risk 

properties or assign them as local or global risks. 
 

 If you enter any risk assignment without entering the risk to the risk register, the risk will 
added to the risk register automatically as long as it is a new risk (has new unique name). 
We recommend entering risk assignment first if you have relatively small project with 
few risks. 

 You may rename a risk in risk register. The risk will be automatically renamed in all risk 
assignments.  

 

Adding risk properties 

Risk properties are attributes that can be used for filtering or searching. While some properties are 
populated automatically (e.g. Creation Date), you can enter specific values as required. You 
define default risk properties in the Default Risk Properties dialog box accessible from the Risk 
menu. 

1. Open the Risk Register. 
2. Double-click on the risk ID to which you want to add properties. 
3. Click the Properties tab. 
4. Add a description in the Description box. 
5. For each property, add a value as required. 

 

Risk properties do not affect calculations, including risk ranking, cost, duration, etc. For example, 
the risk property “Potential Loss in Monetary Terms” does not affect cost calculations. 
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Managing Risk Assignments 

Risk Assignments 
Risks must be assigned to calculate their impact.  If risk is not assigned to any tasks or resources 
it will remain in risk register, but probability, impact, and score will not be shown. 

RiskyProject has two types of risks assignment:  

 Global Risk Assignments – Global risk assignment are those risk assignments, which 
have a chance of affecting the project as a whole and are not limited to specific tasks or 
resources. For example, political or weather risks would be assigned as global. 

 Local Assignment – Local risk assignments are those risks that have a chance of 
affecting only specific tasks or resources. A local risk assignment can affect more than 
one task or resource. For example, risks affecting the delivery of specific equipment for a 
certain phase of a project would be assigned local. 

You can edit or view risk assignments in the following dialog boxes and views: 

View  Dialog/Tab Local or Global  Assigned to 
tasks or 
resources 

Global Risk 
Assignment View  

 Global Risks. Local risks 
can be assigned from 
global risks  

Both task and 
resources  

Risk Register Risk information 
dialog (double click 
on Risk ID), 
Assignment tab 

Both local and global risk  Both task and 
resources 

Any view with task 
information (Gantt 
View, Result Gantt, 
etc.) 

Task information 
dialog (double click 
on Task ID), Risk tab 

Local risks Task 

Resource View Resource 
information dialog 
(double click on 
Resource ID), Risk 
tab 

Local risks Resources 

 

Each risk assignment has the following information. 

 Risks can be assigned to Tasks or Resources 
 Risks are defined by the chance of occurrence (from 0% to 100%). The chance can be 

defined per task (by default) or per duration unit. For example, if there is a 30% chance 
that task can be restarted per day. If task duration is 2 days, the chance of the risk 
occurring per task is 60%. This chance calculation option is defined for all tasks and 
resources for the project in the Risk tab of the Options dialog box: 
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  
 Each risk has a different outcome. Outcomes can be schedule and cost related and non-

schedule related, which you can customize using Risk Outcome dialog (Risk menu). 
Standard schedule-related risk outcomes are shown in the table. 

Outcome Description  

No Impact This is for information only and has no impact 
on project schedule 

 

Relative Delay 

Fixed Delay 

Durations will be expanded in the period, 
defined in the Result field regardless of, 
when the risk occurs. If the Result is 
negative, the task duration will be reduced.  

Relative Cost 
Increase 

Fixed Cost Increase 

Task related fixed costs are increased by the 
amount, defined in the field Result regardless 
of when the risk occurs. If the Result is 
negative, costs are reduced. 

 

Restart Task Tasks are restarted from the moment the risk 
occurs. As a result, the task duration is 
increased.  

 

End Task Tasks are successfully completed when the 
risk occurs. As a result, the task duration is 
reduced.  

 

Cancel Task Tasks are canceled when the risk occurs. As 
a result, the task duration is reduced and the 
task is marked as canceled. 

 

Cancel Task + all 
successors 

Tasks and all its successors are canceled 
when the risk occurs. As a result, the task 
duration is reduced and the task and all its 
successors are marked as canceled. 

 

 The Result of outcome is related to the outcomes “Fixed cost increase”, “Relative cost 
increase”, “Fixed delay”, and “Relative delay”. It defines how much the duration or 
cost will be increased or reduced. Result of outcomes also used for non-schedule risks 
and is defined as a percentage. For example, risk outcome “Technology change” has 
outcome 20%. It also has a verbal definition that comes from Impact labels defined in 
Format Risk Labels dialog (see Format menu). 

 RiskyProject calculates Risk Impact for duration and cost as a result of sensitivity 
analysis and displays this in the Risk Register, Global Risk Assignment views and Risk 
Tabs for Tasks and Resources. Colors are used to indicate the level of correlation 
between the risk and project duration and cost.  

 Red indicates a strong correlation 
 Yellow a medium 
 Green a weak or no correlation 

Colors for threats are the opposite. Particular colors for the risk impact value depend on 
the risk tolerance defined in Format Risk Matrix dialog box. 
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One risk can have different outcomes or different results of outcomes. For example, if a risk 
occurs there is a 10% chance the task will restart, and 10% chance that the task will be canceled. 
To define a risk with alternative outcomes, use the same risk name for the consecutive items. 
RiskyProject will automatically recognize that this is a discrete outcome of the same risk.  Each 
outcome will be given a number (starting at 1) and all will be colored green in the Mutually 
Exclusive Risk Alternative column (read only). 

Mutually exclusive alternatives must: 

 have the same name 
 not be separated by empty rows 
 belong to the same category. For example, if you have the same risk “Change in 

requirements” with outcomes Reduce Quality and Fixed Delay, these outcomes will not 
be mutually exclusive alternatives as they are different risk categories that have different 
impacts. 

 Here is an example of risk assignments:  

 

 

 RiskyProject flags any mutually exclusive alternative outcomes whose sum or 
probabilities are greater than 100% with pink shading. In these cases, the calculation 
results may be incorrect. 

 Use the Indent and Outdent arrows  to group risks and create a risk breakdown 
structure. 

 
 

One risk: “Risks 
affecting…” has four 
mutually exclusive 
alternatives. 

Assign each 
alternative risk to a 
task or resource 

Select Outcome from the 
list of available outcomes. 
This list can be edited in 
Risk->Risk Outcomes 

Add chance 
associated with 
each alternative 

Select the result for 
each alternative’s 
outcome 

Number of mutually 
exclusive alternatives
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Assigning local and global risks 
Once you have added your risks you can start assigning your local risks to tasks and resources. 
You cannot assign the same local risk to both a task and a resource. RiskyProject offers a number 
of ways how risks can be assigned to task and resources. 

Assigning global and local risks using risk register 

This is a preferred method for assigning risk in complex project. This method is also useful when 
you edit risk assignment, for example for mitigation planning. You will be able to view all risk 
assignments in one place.  With the risk register, you can assign both local and global risks. 

1. Open the Risk Register. 
2. Double-click on the risk to which you want to add properties. 
3. Click either the Assign to tasks or resources tab. 
4. Depending upon whether you are assigning local or global risk to a task or resource click on 

the first empty row in either the Assigned to tasks or Assigned to resources tables.  
5. Select the task or resource from the drop-down list. You may select “All Tasks” or “All 

Resources” for global risk assignments. If you select a specific task or resource, it will have a 
local risk assignment. 

6. Click the row ID cell the item you just select to enable the Selected assignment table to the 
right. This is where you define the risk assignment. 

7. Click in the Chance cell to start entering the Chance, Outcome, and Result of the risk. 
8. Click in an additional row to enter a mutually exclusive risk alternative. A risk alternative is a 

different outcome from the same event.  
 

 Use the Pie Chart for mutually exclusive risk alternatives to as a guide for how they 
affect the overall chance that the risk will occur. 

 If you do not enter chance, outcome, or results assignment will not be saved even you 
selected task or resources.  

 

Risks Assignments on the Gantt Chart 
Risks and issues can be shown on the Gantt chart as arrows: 

 

Colors represent the calculated the impact of the risk on all project parameters combined. The 
size of the arrow represents probability. You may click on each risk arrow within a Gantt chart to 
be presented with information about risks: 



RiskyProject Lite Getting Started Guide 

 

26 

 

Managing Uncertainties 
If you have good historical statistical data that is analogous to a particular in your project, we 
recommend that you use these data to model uncertainty in your project as opposed to risk events. 
Be aware of double-counting risk and uncertainty as most of the uncertainty in a project is due to 
the probability of risk events occurring. 

The process of defining uncertainties comprises of the following steps: 

1. Define a 3-point estimate for any of task parameters: cost, duration, and start time. 3 points 
estimates for work will be calculated automatically based on uncertainty in duration. You 
may also define 3 points estimates for the lag.  

2. After you define 3-points estimates, a statistical distribution will be assigned. RiskyProject 
Lite does not present statistical distribution. By default statistical distribution is triangular.  

 

Adding 3-point estimates for task duration and start times 

1. On the Gantt view, double-click on the task ID.  
2. Click the General tab.  
3. Select a Base, Low, and High dates for Start Time.  
4. Select a Base, Low, and High values for Duration. By default when you enter a value for 

duration, the default values for Low and High are calculated based on the defaults set in the 
Duration Options. 

5. Click OK to save the estimates. 

Adding 3-point estimates for task cost  

1. On the Cost Analysis view, select the task to which you want to add cost estimates 
2. Enter cost data for Cost Low, Cost, and Cost High. By default when you enter a value for 

Cost, the default values for Low and High are calculated based on the Cost defaults set in the 
Cost Options.  

3. Click OK to save the estimates. 
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Calculations 
RiskyProject has two types of calculations: 

 Deterministic calculation of current schedule - The default calculation automatically 
performed when you modify a project schedule. As this calculation occurs automatically, 
you do not need to press the Calculation button. This calculation uses the Base input 
parameters (duration, start time, lag) without calculating the effect of risk or uncertainty. 

 Probabilistic (Monte Carlo simulations) – Use this to calculate the project schedule and 
costs with uncertainties and risks.  

Running probabilistic calculations 
 Click the Calculation  button  on the Standard toolbar. You may cancel the 

probabilistic calculation at any time; however, if number of simulations performed is less 
than 20, no probabilistic results will be calculated.  

Ranking non-schedule risks 
You can run a risk analysis on non-schedule risks even if you have not yet entered a project 
schedule. This analysis will provide a risk ranking for all non-schedule risks currently in the risk 
register. For example, if you have non-schedule risks with the outcome “Legal Issues”, you do 
not need to have project schedule to rank these risks. However, these risks must be have a global 
(task or resource) assignment to be analyzed.  
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Analyzing Results 

The Project Dashboard 3x3 
RiskyProject includes the Project Dashboard 3x3.  This view shows the results of your analysis 
in a logical and easy to understand manner. Total project cost, duration, and finish time with risks 
are the mean values for each. Crucial tasks and critical risks are the results of the sensitivity 
analysis.   

Three main project parameters for the current schedule and with risks and uncertainties (mean 
values) 

1. Total Project Cost 
 Project Finish Time 
 Project Duration 

2. Three most crucial tasks 
 Affect on project cost 
 Affect on project duration 

3. Three most critical risks 
 Affect on project cost 
 Affect on project duration 

Results Gantt Chart 
RiskyProject displays the start and finish ranges of each task in the Result Gantt view. The 
calculated project and current deterministic schedules are shown in the same Gantt chart. You can 
use the task bar for deterministic current schedule to compare deterministic and probabilistic 
schedules. 

 

 

You can display Result Gantt associated only with low (optimistic) and high (pessimistic) results.  

Showing or Hiding Low/High Results 

1. Right-click on the chart and a shortcut menu opens. 
2. From the shortcut menu, choose one of the following viewing options: 

 Show Low/High Results 
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 Show Low Results 
 Show High Results 
 Show Current Schedule. 
 

Resource Allocation 
The Resource chart shows the time allocation for a selected resource. 

 

 For the resource chart to open, two conditions must be met: 

 You must select the Chart check box for a resource in the resource sheet. 
 The selected resource must be assigned to a task. 

You can select four different types of resource charts: 

 Peak units: The highest level at which a resource is scheduled for all assigned tasks 
during a given period. 

 Work: The total number of hours a resource is scheduled for all assigned tasks during a 
given period.  

 Overallocation: A resource is over allocated when it has more work assigned than can be 
done in the resource's available time. Overallocation is number of hours a resource is 
scheduled for all assigned tasks over resource's available time. Overallocation can be 
presented only for work (not material) resources.  

 Percent allocation: The percentage of a resource's capacity taken up by all of its 
assigned tasks during a given period. Percent allocation is only available for work (not 
material) resources. 

Overallocation 

Select a checkbox to 
indicate the data that 
you want to view in the 
chart. You can view 
baseline or probabilistic 
results

Select a checkbox to 
indicate which resource 
time allocation will be 
shown on the chart. 
Only one resource can 
be selected at a time.

Right-click on the chart 
to open a shortcut 
menu. You can select 
Zoom In, Zoom Out, 
and Zoom All 
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Selecting the resource chart type 

1. Select the Chart check box associated with the resource. 
2. Right-click on the Resource chart and choose one of chart types from the shortcut menu. 

 

Overallocation for work resources is calculated based on Maximum Units, defined for the 
resource in the Resource view. For example, if maximum units are 150%, overallocation can be 
work above 150%. 

 

Analyzing Cost 
Use the Cost Analysis view to analyze cost on each stage of the project. The Cost Analysis view 
has up to three cost diagrams: 

Cost diagram Description Color When it is shown 

Current schedule 
(budgeted) cost  

Cost diagram with 
current project 
schedule (no risks) 

Red Always when cost for any task 
is defined 

Result cost Cost diagram with 
risk and 
uncertainties 
(calculation results) 

Blue Shown after calculation if 
uncertainties are defined 

Actual cost Cost diagram 
represents actual 
cost  

Green Shown after calculation if 
uncertainties are defined and 
actual cost is available (either 
entered directly or percent 
done for at least one task is 
defined) 

 You may use the slider to determine: 

 Cost Variance (actual vs. budgeted cost)  
 Cost with Risks and uncertainties vs. Current schedule (budgeted) cost. 
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 Use the shortcut menu to manipulate with chart. In particular, instead of presenting a line 
chart of current schedule, result, and actual cost, you can present an area chart by 
choosing Fill Chart from the shortcut menu. 

 

Risk Matrix 
A Risk Matrix is a tool used in the Risk Assessment process that allows you to determine the 
severity of a risk occurring .The Risk Matrix view shows this using the risk probability (y-axis) 
vs. calculated risk impact (x-axis)of the project risks.  

The Risk Matrix view is divided into two sections: a table with a list of risks with their actual 
calculated values for probability, impact, and score. When you select these risks, they are shown 
visually on a matrix, which provides a visual comparison of this data put as well as putting each 
risk into the context of your organization’s risk tolerance. Is the risk in the green, yellow, or red 
areas of the matrix? 

Viewing the Risk Matrix 

1. Select a risk category from the Risks affected drop-down list. Lists of all risks associated 
with the selected risk category are listed in the table. Select All Parameters to view all of the 
risks in all risk categories.  

 

Result cost  

Baseline cost 

Actual cost  

Use the slider to determine 
cost at each period. 

Cost variance is updated automatically 
when you move the slider 
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2. Select the Threats or Opportunities option at the top of the matrix. Threats and 
opportunities cannot be viewed at the same time. 

3. Select the check boxes beside the risk names to view the risks on the Risk Matrix. To hide a 
risk, simply clear the check box. By default, risks with zero impact cannot be selected.  

 

 

Select risk to display it 
on the Risk Matrix 

Select risk category to 
view the risks 

Threats and opportunities are 
viewed separately 
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